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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Disclaimer for PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print
multiple topics from the help information or read the online help in PDF format.

Note: Some topics do not convert properly to PDF, causing format problems. Some elements of
online help are completely removed from the PDF version. Those problem topics can be
successfully printed from within the online help.
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Quick Access Chart
HP IT Executive Scorecard automatically gathers metrics from across your IT systems to build key
performance indicators (KPIs) providing organizations with broad and deep insight into everything
IT does.

The image below provides themain workflow of Executive Scorecard.
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Optional - Install and Manage Content Acceleration Packs
Manage Content Acceleration Packs Using CAP Management in theAdministrator Guide.

Configure Settings
Perform Administration Tasks for Users and Roles in theAdministrator Guide.

Perform Administration Tasks for Foundation in theAdministrator Guide.
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Perform Administration Tasks for Scorecard Settings in theAdministrator Guide.

Perform theMaintenance of the IT Financial Management Module in theAdministrator Guide.

Configure DataWarehouse Settings in theAdministrator Guide.

Configure XS Settings in theAdministrator Guide.

Set up to Bring Data in the System
l Dynamic Data using integrations and Data Warehouse

Integrate with the AM Data Source in theContent ReferenceGuide.

Integrate with the ALM (andQC) Data Source in theContent ReferenceGuide.

Integrate with the BSMData Source in theContent ReferenceGuide.

Integrate with the DP Data Source in theContent ReferenceGuide.

Integrate with the NA Data Source in theContent ReferenceGuide.

Integrate with the NNMData Source in theContent ReferenceGuide.

Integrate with the OOData Source in theContent ReferenceGuide.

Integrate with the IC Data Source in theContent ReferenceGuide.

Integrate with the PPMData Source in theContent ReferenceGuide.

Integrate with the SA Data Source in theContent ReferenceGuide.

Integrate with the SE Data Source in theContent ReferenceGuide.

Integrate with the SM Data Source in theContent ReferenceGuide.

Integrate with the UCMDB Data Source in theContent ReferenceGuide.

Alternate Sources Integration in theContent ReferenceGuide.

Perform Tasks for Data SourceManagement in theAdministrator Guide.

l Static Data
Create andManage Contexts Using Context Designer and Upload Data Using Data Loader in
theAdministrator Guide.

Maintenance
Perform DW ABC tasks.For details, see Perform Tasks for ETLManagement in theAdministrator
Guide.

Back Up Executive Scorecard and Perform Recovery in theAdministrator Guide.

Customize the Studio and Dashboard contents
l Customize the Studio Contents

Configure a Scorecard in theBusiness Analyst Guide.

Create Cascading Scorecards in theBusiness Analyst Guide.

Configure a Perspective in theBusiness Analyst Guide.

Configure anObjective in theBusiness Analyst Guide.
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Configure a KPI or aMetric in theBusiness Analyst Guide.

Manage KPI Breakdowns in theBusiness Analyst Guide.

ManageMetric Breakdowns in theBusiness Analyst Guide.

Modify a KPI or Metric Formula in theBusiness Analyst Guide.

Modify a KPI or Metric Filter in theBusiness Analyst Guide.

Calculate Displayed Values after Configuration Change in theBusiness Analyst Guide.

Recalculate Displayed Values after Configuration Change in theBusiness Analyst Guide.

Schedule Business Context Calculations in theBusiness Analyst Guide.

l Customize Dashboard Pages
Configure a Page Layout in theBusiness Analyst Guide.

Set UpWiring Between Components in theBusiness Analyst Guide.

View and Analyze Results in the Explorer Page in theBusiness Analyst Guide.

View and Analyze the Business Objectives in the Dashboard in theBusiness Analyst Guide.

Add a Historical View Component to a Page in theBusiness Analyst Guide.

Add a Historical Metric View Component to a Page in theBusiness Analyst Guide.

Add a KPI View Component to a Page in theBusiness Analyst Guide.

Add a KPI List Component to a Page in theBusiness Analyst Guide.

Add a KPI Rolodex Component to a Page in theBusiness Analyst Guide.

Add a Page Filter Component to a Page in theBusiness Analyst Guide.

Add a Pie Chart Component to a Page in theBusiness Analyst Guide.

Add a Scorecard Component to a Page in theBusiness Analyst Guide.

Add aWeb Intelligence Report Viewer Component to a Page in theBusiness Analyst Guide.

Add aWeb Intelligence Dynamic Report Viewer Component to a Page in theBusiness Analyst
Guide.

Add a SWF Report Viewer Component to a Page in theBusiness Analyst Guide.

Add aWeb Intelligence Static Report Viewer Component to a Page in theBusiness Analyst
Guide.

Add Xcelsius Reports Viewer Component to a Page in theBusiness Analyst Guide.

Personalize the Dashboard in theBusiness Analyst Guide.

View Results
View and Analyze the Business Objectives in the Dashboard in theBusiness Analyst Guide.

View and Analyze Results in the Explorer Page in theBusiness Analyst Guide.

Configure andManage Allocations in the Financial Analyst Guide.

Configure andManage a Budget in the Financial Analyst Guide.
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Configure and View Cost Explorer in the Financial Analyst Guide.

View the Financial Performance of Your Organization in the Financial Analyst Guide.

Advanced Configurations
Create andManage Contexts Using Context Designer and Upload Data Using Data Loader in the
Administrator Guide.

Add a Context to the Studio in theBusiness Analyst Guide.

Develop New Content Using the Integrated Development Environment in theContent Extension
Guide.

Create Content Acceleration Packs in theAdministrator Guide.
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Step-by-step with IT Executive Scorecard
This section contains basic steps that you can take to begin working with IT Executive Scorecard.

Prerequisites
l Read the IT Executive Scorecard Release Notes available on the Installation DVD. The

document includes release notes, and installation and upgrade information.

l Read the IT Executive Scorecard Support Matrix available on the Installation DVD. The
document includes information about the supported data sources and the requirements.

l Install Executive Scorecard and run the post-install wizard. For details, see the IT Executive
Scorecard Installation and Configuration Guide (interactive document) available on the
Installation DVD.

l Set up the users, permissions, settings, run ETLs, maintenance issues, andmore. For details,
seeGetting Started with Administration Tasks in theAdministrator Guide.

l Troubleshooting issues are detailed in the IT Executive Scorecard Troubleshooting Guide in
Excel format.

Populate Executive Scorecard using Content Acceleration Packs
Content Acceleration Packs are ready-to-import packages that include one Scorecard, several
KPIs, a Dashboard page that displays data in the Scorecard component and its KPI components, a
Context (universe), andmore.You can then use Content Acceleration Packs as the base for further
configuration of KPIs, contexts, Dashboard pages or more, or you can remove the Content
Acceleration Packs. For details, seeManage Content Acceleration Packs in theAdministrator
Guide.

Upload data into Executive Scorecard using .CSV files
You can simply and easily upload data into the Executive Scorecard Studio using .CSV files
without intergrating with external sources or other HP products. The Studio can then be used to
integrate with third party data sources, testing, or for Proof of Concept (POC) sessions. For details,
see Create andManage Contexts Using Context Designer and Upload Data Using the Import
Wizard in theAdministrator Guide.

Populate Executive Scorecard and upload data using integrations with
supported data sources
To view dynamic data in the Dashboard pages and reports, youmust integrate with supported data
sources. For details, seeGetting Started with the Content ReferenceGuide in theContent
ReferenceGuide.

If you installed one of the data sources that have out-of-the-box support, you can use the data-
sourcemanagement integration. For details, see Integrate the Data Sources in theContent
ReferenceGuide.
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For details about the integrations, review the end-to-end flows. For details, see "End-to-End Flows"
on page 63.

Create and customize contexts (universes)
View the out-of-the-box universes created by integrations with supported data sources. For details,
see Reference: Contexts (Universes) in theContent ReferenceGuide.

You can also create your own context (universe) using the existing database tables, and tables
created by importing .CSV files, and creating relationships between these tables. You can select
the entities you want to use to create KPIs in the Studio, and then use these KPIs to build the
relevant Dashboard pages. For details, see Create andManage Contexts Using Context Designer
and Upload Data Using the Import Wizard in theAdministrator Guide.

Combine data and contexts from all methods
You can combine contexts from the Content Acceleration Packs, from tables created using
.CSV files, and tables created by integrating with supported data sources.

You can combine data obtained from the integration with supported data sources and from tables
imported using .CSV files.

Review and customize the contents of the Studio and Dashboard pages
For details on working with the Studio and Dashboard,seeGetting Started with Business Analysis
in theBusiness Analyst Guide.

Review Scorecards, Perspectives, Objectives, and KPIs in the Studio. You can customize these
items. For details, see Configure a Scorecard, Configure a Perspective, Configure anObjective, or
Assign/Unassign KPIs to/from Objectives in theBusiness Analyst Guide.

If you have installed a Content Acceleration Pack, you can review the Executive page in the
Dashboard. You can also create your Dashboard pages by populating them with the relevant
components. For details, see Add a Page to the Dashboard or Configure a Page Layout. Or add
components as described in Prepare the Dashboard Display in theBusiness Analyst Guide.

Work with IT Financial Management
With the IT Financial Management module, you can view financial data from the HP Asset
Manager, HP Project and Portfolio Management data sources in the Finance tab. You can create
allocation scenario for planned costs and actual costs, perform amulti-dimensional cost analysis,
finalize the budget for your organization, and view the financial performance of your organization in
Dashboard pages and reports. For details, seeGetting Started with Financial Planning and Analysis
in the online help or in the Financial Analyst Guide.

Localize and globalize XS: Executive Scorecard
The user interface of HP Executive Scorecard supports multiple languages. For details, see
Localize andGlobalize Executive Scorecard in theAdministrator Guide.

View the Executive Scorecard on a Tablet or a Mobile
For details, see HP IT Executive Scorecard on a Tablet (XS for Tablet Mini App) Overview in the
Getting Started with XS for Tablet or HP IT Executive Scorecard on a Smartphone (XS for
SmartphoneMini App) Overview in theGetting Started with XS for Mobile.

HP IT Executive Scorecard (9.31)Page 13 of 92

Getting Started Guide



View IT Financial Management on a Tablet
For details, see IT XS Financial Management for Tablet Mini AppOverview in theGetting Started
with IT XS Financial Management for Tablet.

Extend your content (Advanced users)
l Develop content and model DWH schema using IDE

The Integrated Development Environment (IDE) allows you to develop content. For details, see
Develop New Content Using the Integrated Development Environment in theContent Extension
Guide.

Other capabilities are detailed in theContent Extension Guide available from the Executive
Scorecard 9.30 in the HP Software Product Manual Site
(http://h20230.www2.hp.com/selfsolve/manuals).
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Executive Scorecard Components
HP IT Executive Scorecard and IT Financial Management include the following user interface
components:

Admin. The component where the administrator sets the users, permissions and roles, and
performs the administration andmaintenance of Executive Scorecard, DataWarehouse, and IT
Financial Management. For details, see "Getting Started" in theAdministrator Guide.

Studio. The component where the Business Analyst can:

l Manage Scorecards, Perspectives, Objectives, Metrics, Metric Breakdowns, KPIs, KPI
Breakdowns, or Orphan KPIs

l Change formulas or filter thresholds, andmore. For concept details about the Studio, see "Learn
About the Executive Scorecard Components" in theBusiness Analyst Guide . For details about
what the Business Analyst can do in the Studio, see "Plan the Executive Dashboard", "Create
the Executive Dashboard Contents" or "Enrich the Dashboard Contents" in theBusiness
Analyst Guide .
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Dashboard. The component where:

l The Business Analyst can create pages and components for the customer. For concept details
about the Dashboard, see "Learn About the Executive Dashboard" in theBusiness Analyst
Guide. For details about what you can do in the Dashboard, see "Prepare the Dashboard
Display" in theBusiness Analyst Guide .

l The Executive can view the pages relevant to the Executive role. For details about what the
Executive can view in Dashboard, see "View and Analyze the Business Objectives" in the
Business Analyst Guide.

l The CIO, IT Financial Manager, IT Financial Analyst, and IT Manager can view IT Financial
Management-related reports. For details, see "View the Financial Perfomance of Your
Organization" in the Financial Analyst Guide.

Explorer. The component where the Executive can:
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l View overtime information about Scorecards, Perspectives, Objectives, KPIs, KPI
Breakdowns, Metrics, Metric Breakdowns, or Orphan KPIs.

l View configuration and additional information.

l Add, edit, and email annotations.

For concept details about the Explorer, see "View and Analyze Results in the Explorer Page" in the
Business Analyst Guide. For details about what the Executive can view in Explorer, see "View and
Analyze the Business Objectives" in the Business Analyst Guide.

Finance. The component where the Financial Analyst can create and enrich the allocations using
Allocations, create allocation scenarios using Cost Explorer, create and publish budgets using
Budget. For details, see "Getting Started with Financial Planning and Analysis" in the Financial
Analyst Guide.

HP IT Executive Scorecard (9.31)Page 17 of 92

Getting Started Guide



Content Acceleration Packs
Content Acceleration Packs (CAPs) are ready-to-import packages that include Dashboard pages
that display Scorecards and components, KPIs, Metrics, Contexts (universes), data (.CSV files),
and documentation for the CAP.

CAPs describe typical stories that show how the correct implementation of Executive Scorecard
drives Performance Improvement and Cost Reduction for the IT organization.

CAPs demonstrate Executive Scorecard capabilities, and helps you add basic elements that can
be used to customize your Dashboard.

For details, see Content Acceleration Packs (CAPs) in theAdministrator Guide.

Getting Started with Integrations
This section provide a quick access to documentation sections relevant to the integrations with
data sources, including the integration procedure, a description of the context, and the list of
relevant KPIs.

Note that the links below all refer to theContent ReferenceGuide and that you can find detailed
information about the KPIs in the List of KPIs and Entities in Excel format.
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Data Source
(Content
Pack)

Context (Universe) Working
with other
data
sources

KPIs

HP
Application
Lifecycle
Management
or HP Quality
Center
For details,
see Integrate
with the ALM
(andQC)
Data Source.

l ALM_Test
For details, see ALM Test
Context

l ALM_Requirement
For details, see ALM
Requirement Context

l ALM_Defect
For details, see ALM_Defect
Context

PPM -
Consolidate
Between
ALM and
PPM

l % of Reopened Defects
(201)

l % of Failed Tests (405)

l % of Tested Requirements
(406)

l % of Critical Defects (407)

l % of Tests Resulting in
Defects (410)

l % of Requirements Traced
to Tests (412)

l Defect Resolution Time
(413)

l Number of Escaped
Defects (414)

l % of Documented
Requirements (432)

l Average Cycle Duration
(435)

l % of Automated Tests
(459)

l % of Reviewed
Requirements (460)

l Average Time to Review
Requirement (462)

l Average Time to Resolve
Production Defect (467)
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Data Source
(Content
Pack)

Context (Universe) Working
with other
data
sources

KPIs

HP
Application
Lifecycle
Management
or HP Quality
Center
(Continued)

l % of Successful Test Runs
(477)

l % of Authorized Tests
(483)

l Detected Vs. Closed
Defects Ratio (484)

l % of Rejected Defects
(485)

l % of Actual vs. Planned
Tests Executed (486)

l % of Completed Tests
(487)

HP Asset
Manager
For details,
see Integrate
with the AM
Data Source.

AssetManagement
For details, see Asset
Management Context

- l % of Software Licenses in
Use (16)

l Avg Age of Hardware
Assets (29)

l Average Time to Procure
Hardware (31)

l % of Change in Assets
Cost (114)

l % of Assets in
Maintenance (115)

l % of Assets Returned to
Supplier (116)

HP
Application
Portfolio
Management
For details,
see Integrate
with the BSM
Data Source.

ApplicationPortfolioManagement
For details, see
ApplicationPerformance Context

APM -
Integrate
BSM and
APM

l Number of Applications in
Lifecycle Categories (701)

l Number of Applications in
the Portfolio (702)

l Average Availability Rating
(704)

l Average Performance
Rating (705)

l AverageMaintainability
Rating (706)
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Data Source
(Content
Pack)

Context (Universe) Working
with other
data
sources

KPIs

HP Business
Service
Management
For details,
see Integrate
with the BSM
Data Source.

l ApplicationPerformance
For details, see
ApplicationPerformance
Context

l AvailabilityManagement
For details, see Availability
Management Context

UCMDB -
Consolidate
Between
BSM and
uCMDB

APM -
Integrate
BSM and
APM

l % of Available Services
(30)

l % of Met Service
Performance (48)

l Mean Time Between
Failures of Services (111)

l Mean Time to Repair a
Service (117)

l % of Non-Encrypted Traffic
(532)

l % of Applications
Availability (600)

l % of Met Application
Performance (604)

l % of Failed Business
Transactions (607)

l % of Affected End Users
by Application Quality (608)

l % of Monitored
Applications (611)

HP Business
Service
Management
and
HP Service
Manager

For details,
see Integrate
with the BSM
Data Source
and Integrate
with the SM
Data Source.

SLM 
For details, see Service Level
Management Context

l % of Met SLAs (99)
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Data Source
(Content
Pack)

Context (Universe) Working
with other
data
sources

KPIs

HP Data
Protector
For details,
see Integrate
with the DP
Data Source

DataProtection
For details, see DataProtection
Context

l Number of Servers with
Non-Encrypted Backup
Data (529_

l Recovery TimeObjective
(650)

l Recovery Point Objective
(651)

l Backup Success Rate
(652)

l Restore Operations
Success Rate (654)

l Average Time to Restore
(655)

l Number of Servers Being
Backed Up (656)

l Volume of Protected Data
(657)

l Time Elapsed since Last
Backup (658)

l Consecutive Backup
Failure Period (659)

The Context includes the
Node entity, so you can create
a KPI based on that entity and
then break it down by service
and/or application.
Do not create a Service to
Application drill down or an
Application to Service drill
down.
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Data Source
(Content
Pack)

Context (Universe) Working
with other
data
sources

KPIs

HP Insight
Control
For details,
see Integrate
with the IC
Data Source.

PowerManagement
For details, see Incident
Management Context

l Average Electricity
Consumption of Data
Center Nodes (707)

l Average Electricity
Consumption of a Node
(708)

l Average Electricity Cost of
Data Center Nodes (709)

l Average Cooling Cost of
Data Center Nodes (710)

l Average Electricity Cost of
a Node (711)

l Average Cooling Cost of a
Node (712)

l Total Power Cost of Data
Center Nodes (713)

The Context includes the
Node entity, so you can create
a KPI based on that entity and
then break it down by service
and/or application.
Do not create a Service to
Application drill down or an
Application to Service drill
down.
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Data Source
(Content
Pack)

Context (Universe) Working
with other
data
sources

KPIs

HP Network
Node
Manager
For details,
see Integrate
with the NNM
Data Source.

NetworkNodeManager
For details, see
NetworkNodeManager Context

l % of Network Devices with
Reachability Issues (515)

l % of Network Devices with
Availability Issues (516)

l % of Utilization of Network
Devices (518)

l Average Throughput of
Network Devices (519)

l Network Latency (520)

The Context includes the
Node entity, so you can
create a KPI based on that
entity and then break it
down by service and/or
application.
Do not create a Service to
Application drill down or an
Application to Service drill
down.

No external
data source

Period
For details, see Period Context

HP Operation
Orchestration
For details,
see
Integrate with
the OOData
Source

OrchestrationAutomation
For details, see
OrchestrationAutomation
Context

l Monthly ROI (564)
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Data Source
(Content
Pack)

Context (Universe) Working
with other
data
sources

KPIs

HP Project
and Portfolio
Management

For details,
see Integrate
with the PPM
Data Source.

l FinancialManagement
For details, see Financial
Management Context

l ProjectPortfolioManagement
For details, see Project
Portfolio Management (PPM)
Context

l % of OpEx (1)

l Innovation Delivery (2)

l % of Project Tasks on
Time (10)

l % of Projects on Time (12)

l % of Projects with
Unresolved Urgent Issues
(13)

l % of Projects Associated
with Business Objectives
(22)

l % Variance of Actual vs
Planned Costs (28)

l Deviation of PlannedWork
Hours (36)

l Average Cost of IT
Delivery Per Customer (42)

l Avg Project Initiation Time
(45)

l % of Project Effort Done by
External Resources (77)

l % of Change in Business
Service Cost (101)

l % of IT POR vs Total
Revenue (105)

l % of Projects Budget at
Risk (106)

l % of Healthy Projects (107)
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Data Source
(Content
Pack)

Context (Universe) Working
with other
data
sources

KPIs

HP Project
and Portfolio
Management
(continued)

l % of Change in Project
Cost (113)

l Avg Delivery Time of New
Products or Services (119)

l % of Time Invested on
Strategic Projects (120)

l % of Actual vs Planned
Projects Cost (121)

l Demands Backlog (362)

l Average Time to Evaluate
Proposal (392)

l Average Age of Active
Proposals (419)

l Average Age of Active
Demands (427)

l Proposals Backlog (488)

l Project Scope Changes
Backlog (489)

l % of Approved Project
Scope Changes (490)

l Time to Resolve Project
Scope Change (491)

l Average Time to Evaluate
Scope Change (546)

l Number of Opened Risks
(547)

l Number of Identified
Issues (548)
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Data Source
(Content
Pack)

Context (Universe) Working
with other
data
sources

KPIs

HP Server
Automation
For details,
see Integrate
with the SA
Data Source
and Integrate
with the NA
Data Source.

l PolicyRemediation
For details, see
PolicyRemediation Context

l PolicyCompliance
For details, see
PolicyCompliance Context

l PolicyComplianceStatus
For details, see
PolicyComplianceStatus
Context

l SA alone:

n Average Time to Deploy
an Application (510)

n SA and NA:

o % of Managed Nodes
(86)

o % of Nodes with
Compliance Issues
(301)

o Average Time to
Configure a Node
(501)

o Average Time to Run
Compliance (502)

o Mean Time to
Recover from Non-
Compliance (503)

o Average Time to
Provision a Node
(504)

o Average Time to
Patch a Node (511)

o % of Successful
Patches (513)

o Frequency of Policy
Checks (530)

o Ratio of Security
Related Nodes (563)

l SA, NA, and Arcsight

n Mean Time for
Hardening (539)

The Context includes the
Node entity, so you can create
a KPI based on that entity and
then break it down by service
and/or application.
Do not create a Service to
Application drill down or an
Application to Service drill
down.
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Data Source
(Content
Pack)

Context (Universe) Working
with other
data
sources

KPIs

HP Storage
Essentials
For details,
see Integrate
with the SE
Data Source.

StorageManagement
For details, see Storage
Management Context

l % of Used Storage System
(714)

l % of Free Storage System
(715)

l Number of Critical Storage
Events (716)
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Data Source
(Content
Pack)

Context (Universe) Working
with other
data
sources

KPIs

HP Service
Manager
For details,
see Integrate
with the SM
Data Source.

l ServiceDesk
For details, see Service Desk
Management Context

l IncidentManagement
For details, see Incident
Management Context

l ChangeManagement
For details, see Change
Management Context

l % of First Call Resolution
(7)

l % of Reopened Incidents
(14)

l % of Emergency Changes
(18)

l % of SLOs Met (24)

l % of SLAs Planned to be
Expired (25)

l Downtime% of SLAs (27)

l Change Success Rate (32)

l % of Satisfied Customers
(35)

l Incident Aging (40)

l % of Interactions in
Backlog (49)

l % of Unauthorized
Implemented Changes (50)

l Mean Time Between
Failures (56)

l Mean Time ToResolve
Customer Incident (57)

l Mean Time ToResolve
Service Problems (58)

l NOC FTE Efficiency (59)

l %Maintenance TimeUsed
For Repair (60)

l %Of Incidents That Are
ReportedMore ThanOnce
By The Customer (61)
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Data Source
(Content
Pack)

Context (Universe) Working
with other
data
sources

KPIs

HP Service
Manager
(Continued)

l %Of Problems Reported
By Customers (62)

l %Of Problems Resolved
By DueDate (63)

l % of Problems By Cause
Type (64)

l Service Problem
Resolution Time (65)

l % of Escalated Incidents
(109)

l AvgOutage Duration (110)

l Avg Interaction Closure
Duration (118)

l % of Changes Resulting in
Outage (122)

l Number of Opened
Incidents (123)

l % of Unplanned Changes
(124)

l Change Backlog Size (126)

l Number of Completed
Changes (127)

l Incidents Backlog Size
(128)

l Number of Closed
Incidents (129)

l Incident Resolution Time
(130)

l % of Incidents Classified
as Security Related (302)

l Approved vs. Rejected
Changes (560)

l Automated Change
Implementation Rate (561)

l Automated Change
Implementation Success
Rate (562)
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Data Source
(Content
Pack)

Context (Universe) Working
with other
data
sources

KPIs

HP Universal
Configuration
Management
Database

For details,
see Integrate
with the
UCMDB Data
Source.

RequestManagement (Demand
Management)
For details, see
RequestManagement
(DemandManagement) Context

There are no KPIs dedicated
to the UCMDB data source.

The Context includes the
Node entity, so you can create
a KPI based on that entity and
then break it down by service
and/or application.
Do not create a Service to
Application drill down or an
Application to Service drill
down.

Common Use Cases
This section provides the basic scripts for common use cases, a link to amovie presenting the
script, and a link to the relevant page in the documentation where you can findmore conceptual
information and a detailed description of the relevant UI pages or dialog boxes.

This section includes the following topics:

Use Case - Create a New Dashboard Page 32

Use Case - Build a Scorecard Tree and Create a New KP 34

Use Case - Create a New Metric 36

Use Case - Create KPI Breakdowns and Configure BreakdownOverride 36

Use Case - Display andModify KPI Properties 37

Use Case - Configure a KPI or Metric Formula 38

Use Case - Create Cascading Scorecards 39

Use Case - Add an Annotation, Send Email, Save as PDF, and Print 40

Use Case - Filter Components 41

Use Case - Schedule an Automatic KPI Context Calculation 42

Use Case - Create a New Business Context 43

Use Case - Create, download and upload Content Acceleration Packs (CAP) 45

Use Case - Renew a License 47

Use Case - Create a New User (Permissions and Roles) 47

Use Case - Activate or Deactivate a Data Source 49

Use Case - Run the ETL 50
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UseCase - ITFM - Create an Allocation Scenario 51

Use Case - ITFM - Create Budget Template 53

Use Case - ITFM - Edit a Budget 54

Use Case - ITFM - Analyze, in the Dashboard, Financial Data Based on an Allocation 55

Use Case - ITFM - Analyze Allocation Scenarios Using Cost Explorer 56

Use Case - IDE - Overview 57

Use Case - IDE - Develop a New Entity 58

Use Case - IDE - Extract an Existing Entity from the New Data Source 60

Use Case - End-to-End Data Flow 62

Use Case - Create a New Dashboard Page
In this section you will learn how to create a new Dashboard page, define the page layout, and add
components.

1. In the application, close all tabs to open the Dashboard.

2. Click theNew Page button in the Dashboard toolbar. An empty page appears.

It has a single vertical layout by default:

For more details, see Add a Page to the Dashboard in theBusiness Analyst Guide.
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3. Click to split the page into two horizontal components.

4. From the layout tools in the upper left area, click Switch to Horizontal.

The layout is now oriented horizontally:

For more details, see Configure Page Layout – Configure the Layout of Components on a Page
Scenario in theBusiness Analyst Guide.

5. Click Switch to tabs to create amulti-tabbed area in the left pane:
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Formore details, see Configure Page Layout – Create a Tabbed Component in a page
Scenario in theBusiness Analyst Guide.

Note: To remove an area click theRemove Layout icon.

6. Now, add components to the page layout you created.

7. Click the ‘Add component’ icon in one of the areas, or click theComponents button in
the top right menu bar to open theComponents dialog box..

8. In the Component Gallery page that opens, double-click the component to place it in the layout
area, or select the component and drag it to an area on the page, and close the Component
Gallery page.

9. Select the component you want to add to one of the areas you created, and drag it to that area.
Do the same for all the other areas.

For more details, see "Modify Component Categories" in theBusiness Analyst Guide.

10. For a Tab area, drag the components you wish to add and for each component a new tab will
appear.

11. After adding the relevant components to the relevant areas, save the page by clicking theSave
icon. Enter a page name, add a description, and decide under which category the page will be
saved. If you do not select a category, the page is saved in theNon Categorized category.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

Use Case - Build a Scorecard Tree and Create a
New KP

In this section you will learn how to create a new KPI and build a Scorecard tree.
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You can create a Scorecard tree in the Active KPIs pane in 2 ways: either by selecting a Scorecard
from one of the Trees in the KPI Library pane and dragging it to Active KPIs pane, or by creating a
new Scorecard tree directly in the Active KPIs pane.

1. Click theStudio button (top right corner) to open the Studio.

2. In theActive KPIs pane, select themain root folder and click theCreate a new entity
icon.

3. Select theScorecard option in themenu that opens.

A New Scorecard node is added at the bottom of the tree in theActive KPIs pane. The new
Scorecard has an automatically generated unique name. The Scorecard is automatically
selected in the tree. You can then configure the Scorecard. For details, see "Configure a
Scorecard".

For more details, see "Create Active Scorecards, Perspectives, Objectives, Metrics, or KPIs"
on page 1 in theBusiness Analyst Guide.

4. Name the Scorecard entity accordingly, add description, and click Create. For more details,
see "Configure a Scorecard" on page 1 in theBusiness Analyst Guide.

5. Select the Scorecard entity you just created , and click once again theCreate a new entity

icon , or use the right-click menu and select Create new > Perspective.

For more details, see "Create Active Scorecards, Perspectives, Objectives, Metrics, or KPIs"
on page 1 in theBusiness Analyst Guide.

6. Name the Perspective, add a description, and click Create. For more details, see "Configure a
Perspective" on page 1 in theBusiness Analyst Guide.

You can create several Perspectives under a single Scorecard.

7. Select the Perspective entity, click theCreate a new entity icon and select Objective.

For more details, see "Create Active Scorecards, Perspectives, Objectives, Metrics, or KPIs"
on page 1 in theBusiness Analyst Guide.

8. Name theObjective, enter a description, if needed change the calculation period and rule. Click
Create to complete the Scorecard tree creation.

For more details, see "Configure anObjective" on page 1 in theBusiness Analyst Guide.

You can create several Objectives under a single Perspective.

EachObjective can contain more than a single KPI or even several Objectives.

9. After creating the Scorecard structure you can drag one of the OOTB KPIs from the KPI Library
or simple create a new KPI.

10. To create a new KPI, select the relevant Objective, click theCreate a new entity icon
and select KPI.

For more details, see "Create Active Scorecards, Perspectives, Objectives, Metrics, or KPIs"
on page 1 in theBusiness Analyst Guide.

11. Name the new KPI, enter a description, set the thresholds, change the default Business
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Context, and enter the relevant formula. Click Create to complete the KPI creation.

For more details, see Configure a KPI or aMetric in theBusiness Analyst Guide.

12. To find out the expected result for the KPI you created, click the Test KPI button. If the result
does not meet your expectation, modify the KPI accordingly and check again the expected
result.

13. Once the KPI you created is ready to be calculated, you will need to launch the Engine by
clickingCalculate now. For more details, see Calculate Displayed Values after Configuration
Change in theBusiness Analyst Guide.

The engine will calculate the new KPI result and you will be able to present it in the Dashboard.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome,
click Help in the top right corner of the applicationmain page and select theMovies option.
Select the relevant movie. For details, see "Movies" on page 89.

Use Case - Create a New Metric
In this section you will learn how to create a new Metric.

1. Click theStudio button (top right corner) to open the Studio.

2. In theActive KPIs pane, select themain root folder and click theCreate a new entity
icon and selectMetric.

3. Name the new Metric, enter a description, set the units and the calculation period. Click Create
to complete theMetric creation.

For more details, see Configure a KPI or aMetric in theBusiness Analyst Guide.

4. Click theCalculation Details tab to select the relevant Business Context and to set the
formula and filter. Once you are done, click Create .

5. To find out the expected result for theMetric you created, click the Test Metric button. If the
result does not meet your expectations, modify theMetric formula and check again to check
the expected result.

6. Once theMetric you created is ready to be calculated, launch the Engine by clickingCalculate
now. For more details, see Calculate Displayed Values after Configuration Change in the
Business Analyst Guide.

The engine will calculate the new Metric result and you will be able to view it in the Dashboard.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

Use Case - Create KPI Breakdowns and Configure
Breakdown Override

In this section you will learn how to create a KPI Breakdown and configure BreakdownOverrides.
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1. Click theStudio button (top right corner) to open the Studio.

2. In the Active KPIs pane, perform one of the following actions:

n Select the relevant KPI, and click theCreate a breakdown for the KPI button in the
toolbar.

n Right-click the relevant KPI, and select Breakdown in themenu that opens.

3. Select the entity and field or dimension with which you want to breakdown the KPI.

The KPI Breakdown is inserted as a child of the KPI with the Breakdown icon.

Example of a KPI Breakdown:

You can addmore than one breakdown.

You can add other KPI Breakdowns to the same KPI or you can create a second level
Breakdown below the Breakdown you have just created. There is no limit on the number of KPI
Breakdowns you can create, but keep inmind that it may affect the performance of the XS
engine.

Once you have created a KPI Breakdown, the new entity derives its target threshold
configuration and its owner from the parent KPI.

For more details, seeManage KPI Breakdowns in theBusiness Analyst Guide.

4. To set different thresholds or owners to a KPI Breakdown:
a. youmust calculate the KPI and its KPI Breakdowns. To do so, select theCalculate

options button and select Calculate now. The Calculationmight take some time. For more
details, see Calculate Displayed Values after Configuration Change in theBusiness
Analyst Guide.

b. Click theAdd a Breakdown Override option and select the relevant KPI Breakdown for
which you want to override thresholds and owner.

c. Adjust the thresholds and the owner details and click OK. For more details, seeManage
Overrides in theBusiness Analyst Guide

Repeat this step for any KPI Breakdown you want to override.

You can remove or edit the overrides you have created by clicking theDelete andEdit
icons near each record.

At the end of the process, click Save to keep themodifications youmade and run the
calculation oncemore to update the results based on your last modifications.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

Use Case - Display and Modify KPI Properties
In this section you will learn how tomodify a KPI configuration.
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1. Click theStudio button (top right corner) to open the Studio.

2. In theActive KPIs pane, select the KPI you want to modify.

3. In the right pane, select theConfiguration Details tab.

4. In theGeneral – KPI area you can change the KPI name, select a different unit or enter a
custom unit, and you you can also change the calculation period of the KPI.

5. In theResult Threshold area, you can change the Threshold direction, includemarginal
status, and set the thresholds boundaries freely.

6. In theMetadata area, you can add to the KPI additional information that will be shown in the
Dashboard and the Explorer.

7. In theBusiness Motivation field you can add the business justidication of the KPI and in the
Additional info field you can add information that will be displayed with the KPI. This can be a
URL, a BO report, another Dashboard page and even Xcelsius reports.

8. In addition, you can set an owner for the KPI. The owner will get the annotations of the KPI
when they are added for the KPI in the Explorer tab.

9. Save your changes and click theCalculation Details tab.

10. In theCalculation Details tab, you can change the KPI’s business context and you can
update the KPI formula and filter.

11. Use theComments field to store any additional information.

12. Save your changes and click the Test KPI button to check if the current configuration gives
you the expected result.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

For more details, see Configure a KPI or aMetric in theBusiness Analyst Guide.

Use Case - Configure a KPI or Metric Formula
In this section you will learn how to configure a KPI or aMetric formula.

1. Click theStudio button (top right corner) to open the Studio.

2. In theActive KPIs pane, select the KPI or Metric whose formula you want to modify.

3. In the right pane, click theCalculation Details tab and click theOpen the Formula Builder
link.

4. Remove the current formula and start creating your own formula.

Example: 

Let’s create a formula with the COUNT function (for this example wewill use Incident
Management as Business Context).
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1. From the Functions pane, double click theCOUNT function or select theCOUNT
function and click the Add button, or select theCOUNT function and drag it to the bottom
area.

The syntax of the formula appears above in the description area.

The COUNT function returns the number of entities satisfying the given Filter Expression
condition. For example, if you want to count the number of open incidents you need the
following entities:

n Entity to count is Incident

n Filter expression is Incident.Status = ‘Open’

2. Let’s add these entities to theCOUNT function according to its structure:
a. Click inside the formula brackets, go to theVariables pane, and locate the Incident

entity (you can use the search field).

b. Double-click the entity or select the entity and click theAdd button.

The Incident entity appears in the first section of the COUNT function.

3. Move to the second section of theCOUNT function, and locate theStatus entity in the
Variables pane.

4. Add it to the formula.

5. You can now add the condition operator equal and select theOpen value from the list.

The formula should be as follows: COUNT (Incident, Incident.Status=’Open’)

1. Click Validate to make sure that the syntax is correct.

2. Click OK to close the dialog and click Save to save the changed formula.

3. Use the Test KPI button to check if the result you are getting according to the configuration,
meets your expectation. If not, modify it and check it again.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

For more details, see Configure a KPI or aMetric in theBusiness Analyst Guide.

Use Case - Create Cascading Scorecards
In this section, you will learn how to create Cascading Scorecards. Cascading Scorecards enable
the user to view both a Scorecard and a Cascading Scorecard in a single Scorecard component in a
Dashboard page.

To configure the Cascading Scorecards of a specific Scorecard, youmust havemore than one
activated Scorecards in the Active KPIs pane.

To provide the executive with the capability of drilling down to a subordinate's Scorecard, both
Scorecards have to be defined in the Studio and have to be active Scorecards.
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1. Click theStudio button (top right corner) to open the Studio.

2. In theActive KPIs pane, select the parent Scorecard from which the executive can drill down.
(the Scorecard for which you want to create Cascading Scorecards).

3. Click theManage Cascading Scorecard link and double-click or use the arrow buttons to
move the Scorecard you want to cascade to from theAvailable Scorecards pane to the
Assigned Scorecards pane.

Note that you can select multiple Scorecards.

4. Click OK and then click Save to save the configuration.

Now, the executive will be able tomove from themain Scorecard to its Cascading Scorecards and
to view their data with a single click.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

For more details, see Create Cascading Scorecards in theBusiness Analyst Guide.

Use Case - Add an Annotation, Send Email, Save
as PDF, and Print

In this section you will learn how to add an annotation, send an email, save information in PDF
format or print information related to a Scorecard, Perspective, Objective, KPI, Metric, KPI
Breakdown, or Metric Breakdown.

You can perform these tasks from either the First Level Navigation tooltip in the Dashboard or from
within the Explorer tab:

1. Access:
a. The First Level Navigation tooltip: in the relevant Dashboard page component, mouse over

the page icon near the relevant entity. Once the tooltip appears, move the cursor to the
Action bar at the bottom.

b. The Explorer tab: double-click the Page icon or click theShow more link inside the First
Level Navigation tooltip. The same action bar appears at the bottom of the Explorer
window.

2. You can now:

n Add an annotation, click theAdd annotation button, add the text and click theAdd
button to post the annotation.

n Send an email to the Owner of the entity, click theSend Mail icon. If you send an
email right after adding an annotation, the content of the annotation is automatically added to
the email.

n Export a First level navigation tooltip to a PDF file, click theSave snapshot icon.

n Print the content of the tooltip, click thePrint icon.
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n View additional information related to that specific entity, click theAdditional info icon.
The icon is enabled only if additional information was added to the entity in the Studio.

For more details, see View and Analyze Results in the Explorer Page in theBusiness Analyst
Guide.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

Use Case - Filter Components
In this section, you will learn how to filter the different Dashboard components and how to present
the filtered data in a Dashboard page.

You have 2main options to filter the data presented in the components:

l You can filter each component separately by clicking the Configure Component icon and setting
the component configuration according to the support settings.

l You can use the Page Filter component. When you use this component, each selection you
make in the Page filter, impacts all the other components in the page.

To filter using the Page Filter component:

1. In the Executive Dashboard, select the relevant page (click thePage Gallery button if the
page you want does not already appear in the Dashboard).

2. Click theComponents button.

3. In the Component Gallery dialog box that opens, double-click the Page Filter component to
place it in the layout area, or select the component and drag it to an area on the page, and close
the Component Gallery page. For details, see Component Gallery Dialog Box.

n If the target area is hidden by the Component Gallery dialog box, click the Component Gallery
dialog box title bar and drag it to another location on your screen.

n If you are dragging a new component to a target area that already has a component defined,
drag the new component to the title bar of the target area, and not to the part of the
component that is colored white.

4. Close the Component Gallery dialog box.

5. The basic configuration of the Page Filter component includes thePeriod filter. Select a time
period and click the Filter button and all the data of the components located on the same page,
is filtered automatically based on the selection youmade.

6. You can add additional fields to the component and filter the page according to them. To do so,
click theConfigure Component icon. A list of available dimensions appears in the
Available dimensions pane. Those dimensions are created based on the KPI or Metric
Breakdown configurations you set earlier in the Studio.

7. Select one of more dimensions andmove them to theSelected dimensions area.
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8. Click OK. The new dimensions appear in the Page Filter and you or the Executive user can use
them to refine, in addition to the time period, the filtering of the other components of the page.

9. To clean the filter selection, click theClean filter option.

10. Once you filter the page according to your needs, click Save.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

For more information about the Page Filter component, see Add a Page Filter Component to a Page
in theBusiness Analyst Guide.

Use Case - Schedule an Automatic KPI Context
Calculation

In this section, you will learn how to schedule an automatic context calculation, so the calculation
runs automatically according to your configuration and the data that is presented in the Dashboard
is the latest data.

The calculation engine will now run automatically according to your settings.

1. Click theStudio tab.

2. In the Active KPIs pane, select the relevant KPI, click theCalculation options button,
and select theSchedule context calculation option.

Note that you schedule the calculation per Business Context.

3. In the Business Context Calculation Scheduling dialog box, select the relevant business
context in the drop downBusiness Context list, and in theSchedule details area, enter the
day and time when you want to run the scheduled calculation. Click Save.

You can select additional Business Contexts and schedule their calculation run in the same
way. 

4. Once the calculations are scheduled, click Save to save the configurations.

At the scheduled time, the following processes take place:

l The calculations of the KPIs associated with the business context are performed for the current
period.

l TheObjectives including these KPIs are also calculated for the current period.

l The Scorecards and components that include these KPIs are refreshed when you open the
Dashboard.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.
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Use Case - Create a New Business Context
In this section you will learn how to create a new Business Context.

Executive Scorecard enables the importation of data into the Studio using all the out-of-the-box
integrations with other HP products.

In addition, you can import data from custom CSV files into the application and you can use that
data for KPIs andMetrics as well.

1. Upload data from the .CSV file into the Studio:

a. Create the .CSV file containing the data you want to use in the Studio (for
example: latest.CSV).

b. InExecutive Scorecard, click the Admin > Semantic Layer > Semantic Layer. In the
Context Management page, click Launch Content Designer.

The Context Designer page appears.

c. Select Create a new context.

d. Enter the name of the new Context in theContext Name field and click Open Repository.

TheRepository area opens.

e. Click theAdd Table button to open the Import Wizard (data loader). Follow the steps
to upload the .CSV file. For details, see Create andManage Contexts Using Context
Designer and Upload Data Using the Import Wizard in theAdministrator Guide.

f. Click theUpload data file button.

The file is uploaded. The upload operation saves the changes youmade to the .CSV file.
Once the import procedure is completed, the new table is lisetd in theExternal Tables
section in the Repository.

2. To use a richer model, you can import multiple CSV files where a column in one file is a
reference to a column in another file. To do that, continue uploading the relevant CSV files that
can be joined together.

3. Join imported tables and internal tables to create the Context as follows:

a. Once you finished uploading all the CSV files, drag the tables you created to the design
area.

b. To link two tables, drag an attribute from one table to the attribute of the second table that
contains the data that can be joined. You can createmultiple connections.

c. When the structure of the Context is ready, drag the tables to theEntities pane.

d. In theEntities pane, you can change the entities names, remove unnecessary attributes
and configure additional features.

e. Run theValidation before saving the new Context.

4. Click theAdmin tab and refresh the list of contexts to check that the new context is listed.

5. After you have create a context, you can create a new KPI using the enhanced datamodel.
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6. Click Studio and create a new KPI in the Active KPI pane.

a. Configure the KPI name and thresholds and change the Business Context to the one you
just created.

b. Click theCalculation Details tab and click Open the Formula Builder. Create the
formula you wish to use to calculate the KPI.

The variables listed in the Formula Builder dialog box correspond to the attributes of the
CSV tables. For more details, seeModify a KPI or Metric Formula in theBusiness Analyst
Guide.

7. Validate the KPI and click Save.

8. Click Test the KPI to check if the result meets your expectations.

9. Once the KPI configuration is done, calculate the KPI and present it in the relevant Dashboard
page.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.
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Use Case - Create, download and upload Content
Acceleration Packs (CAP)

In this section you will learn how to create, download, and upload Content Acceleration Packs
(CAPs).

Create the new CAP:
1. Prerequisite: Before creating the CAP, make sure you have already created all the relevant

Scorecards, KPIs , Metrics, Pages and Contexts that you wish to include in the CAP and that
they have been calculated with the expected results. If you find that some content is missing,
go back and create it. Once this is done. you can start creating the CAP.

2. In Executive Scorecard, click Admin > Content Acceleration Pack.

The page displays the list of available CAPs.

3. Click theCreate a new CAP button to open the Create Content Acceleration Pack wizard
where you can create the CAP.

Click Next and specify the CAP name, author, version, description, recalculation date and link
to any relevant document.

Click Next and in theSelect Pageswizard page, select the pages you want to include in this
CAP.

Note: Once you have selected a Page, the Scorecards, KPIs, andMetrics that are
included in that page and the Contexts that are assigned to the KPIs included in the page,
are automatically selected. If you want to add to the CAP additional elements like
Scorecards, KPIs, andmore, click theNext button andmodify your selection in the other
pages of the wizard. Otherwise you can jump directly to the Summary wizard page.

4. Click Create to create the CAP. Once the CAP is created you cannot modify it. The new
CAP is displayed in the list of CAPs in the CAP Management page. In the right pane you can
see the contents of the CAP you have just created. For details, seeManage Content
Acceleration Packs Using CAP Management.

For additional details, see Create Content Acceleration Packs in theAdministrator Guide.

Activate the CAP:
By default, the new CAP is deactivated.

When you activate a CAP, all the content of the CAP is added to current data (Contexts, KPIs,
Pages, etc.) and a recalculation is performed according to the CAP definitions.

To activate a CAP:

1. Prerequisites:

The CAP is in the list of available CAPs and is not activated.

2. In Executive Scorecard, click Admin > Content Acceleration Pack..

The page displays the list of available CAPs.
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3. Select the relevant CAP and click Activate.

You get a notification that the CAP is being activated. Click Yes to complete the Activation. It
takes a few minutes.

If a CAP that shares the same content was already activated, an alert warns you that
activating the new CAP will override the overlapping instances.

Once the activation is complete, an indication is added to the CAP.

4. You can now:

n View the Business Context details in Context Designer. For details, see Create and
Manage Contexts Using Context Designer and Upload Data Using Data Loader.

n View and expand the Scorecard tree in the Active KPIs pane. For details, see Activate
Scorecards, Perspectives, Objectives, Metrics, or KPIs Using Templates in theBusiness
Analyst Guide.

n View the Scorecard, and KPIs configuration in the Configuration Details, and Calculation
Details tabs. For details, see Configure a Scorecard or Configure a KPI or aMetric in the
Business Analyst Guide.

n View the Content Acceleration Pack page in Dashboard. For details, seeManage Page
Categoriesin theBusiness Analyst Guide.

n View information in Explorer. For details, see View and Analyze Results in the Explorer
Pagein theBusiness Analyst Guide.

For additional details, see Activate a CAP in theAdministrator Guide.

Download the CAP:
To download a CAP and save it to the local system ato be used in other environments:

1. In Executive Scorecard, click Admin > Content Acceleration Pack tab.

2. Select Content Acceleration.

The page displays the list of available CAPs.

3. Click to open a browser dialog box where you can select where you want to download the
CAP.

The CAP .ZIP file is saved at that location.

For additional details, see Download a CAP to the user's local system in theAdministrator Guide.

Upload the CAP:
You can also add the CAP to your Executive Scorecard application by uploading it.

To upload a CAP from the local system to the Executive Scorecard application:

1. Prerequisites:

n The .ZIP file of the CAP you want to upload is copied to your file system.

n A corresponding CAP (with the sameUUID) does not already exist in the Executive
Scorecard application.
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2. In Executive Scorecard, click Admin > Content Acceleration Pack..

The page displays the list of available CAPs.

3. Click to open a browser dialog box where you can select the relevant .ZIP file
corresponding to CAP you want to upload .

4. Check theActivate CAP after upload checkbox if you want to activate the CAP
automatically when the upload is completed.

For additional details, see Upload a CAP from the user's local system to the Executive Scorecard
application in theAdministrator Guide.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

Use Case - Renew a License
In this section, you will learn how renew your Executive Scorecard license.

Renew your license

1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start
> Programs > HP Executive Scorecard.

2. In the Administration folder, select License Renewal.

The License Renewal wizard opens.

a. Click Next on the LicenseManagement page.

b. Select Load a permanent or temporary license and click the Load button to browse to
the location of the license file.

c. A validation check runs. After the validation passes, click Next to complete the renewal.

3. Disable HP Executive Scorecard and then enable HP Executive Scorecard on all servers so
the new license can take effect.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

Use Case - Create a New User (Permissions and
Roles)

In this movie, you will learn how to create a new role and grant it permissions. Then you will learn
how to assign the role to a group of users and how to add a new user to that group.
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1. Create a role:

a. Select Admin > Users and Roles > Role Management.

The Role pane displays a list of predefined roles. Click each Role, to display the sets of
permissions that are configured for the Role.

b. In the Roles area, click to create a new role.

c. Enter the name and description for the role.

d. Click OK to save your role.

For more details, seeManage Roles in theAdministrator Guide.

2. Grant permissions to the role:

a. In the Roles area, select the role you created and click . The Assign Permission to Role
wizard opens.

b. Select the relevant permissions from the list.

c. You can assign resources to some of the permissions if available. Click to open the
Assign Resources to Permissions page in the Assign Permission to Role wizard. Select
a permission and use the arrows tomove the required environments from the Available
Resources list to the Selected Resources list.

d. Click to addmore permissions if needed.

e. Click Finish after adding all the relevant permissions

For more details, seeManage Roles in theAdministrator Guide.

3. Create a group and assign a role to the group:

You can assign a role to a user and to a group of users. Lets create a group and assign a Role
to the group.

a. Select Admin > Users and Roles > User Management.

b. Select a user or group from theUsers & Groups tab.

c. In theUsers & Groups tab, click Add group under the root .

d. Enter theGroup Name andGroup Description and click OK. The group is added under
the root.

e. Click OK to save your selections.

For more details, seeManage Users in theAdministrator Guide.

4. You can now assign a Role to the group by clicking the Assign Role button:

a. Select the role you created from theAvailable Roles list and use the arrows tomove the
role to theSelected Roles list.

Note that you can view the roles permissions at the bottom of the Assign Roles dialog box.

For more details, seeManage Roles in theAdministrator Guide.

5. Click OK to save your configuration.
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6. You can now create a User in the group and assign the new Role to that user:

a. Click User Management.

b. In theUsers & Groups tab, select the group and click Create user icon. TheAdd
user dialog box opens.

c. Enter the Login name, a Display name, an Email, a password, and click OK.

The corresponding user is created in the group. The groups roles are automatically
assigned to the new user. To assign a role to the user directly, click the user and assign a
role in the sameway we assigned a role to a group.

For more details, seeManage Users in theAdministrator Guide.

As soon as you create a user and you assign it a Role– you can use that user to log in to Executive
Scorecard.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

Use Case - Activate or Deactivate a Data Source
In this section, you will learn how to activate and deactivate the different Data Sources supported
by Executive Scorecard. The Data SourceManagement UI also enables you to edit configurations
and test the database connections.

Add and activate a new data source instance:

The process of integrating a data source into the DataWarehouse is done through activation of the
source instance.

1. Select Admin and then Data Source Management.

2. Click theAdd data source to open the Data source wizard. The Add Data Source page
opens.

3. Select the data source type and click Next.

The relevant data source page opens.

4. Enter and select the configuration parameters.

5. Complete the wizard.

The data source instance is activated.

6. If a data source instance has already been activated and deactivated, click next to the
specific source and the source is activated.

This process verifies the configuration and then finalizes the connection between Executive
Scorecard and the Data Source.

Note: You can deactivate the source and stop the integration process, in order to change
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configuration details.

1. Click and the deactivation warning opens.

2. Click OK.

Once you have deactivated the Data Source, data from this source is not taken into the ETL
process.

Once a data source is configured, the next step is to run the actual ETL process.

Edit data source settings and test the connection:

1. If necessary, deactivate the data source by clicking .

2. Click Edit Settings and edit the configuration parameters.

3. Click Next to validate your changes and test the connection to the data source.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

Use Case - Run the ETL
In this movie you will learn how to run the ETL.

Note: Before running the ETL, make sure you have activated the relevant data source or in case
you are using Alternate sources, make sure they are activated.

The ETL process includes 3major steps:

To load or resume a batch job:

1. Select Admin > ETL Management .

2. When there is no running batch (stream state is None) or the running batch is in a suspended

state (stream state is Suspended), click to load or resume a batch.

To verify or schedule the run_steps command:

1. Click in the Stream Information area.

2. The Stream Scheduler dialog box opens.

3. Select theRun-Steps Scheduler tab.

4. Click Add New to create a new schedule for a specific stream.

5. Click Save.

6. Click Delete to delete a displayed schedule. You can then add a new one to replace it.

To schedule a batch job:

HP IT Executive Scorecard (9.31)Page 50 of 92

Getting Started Guide



1. Click in the Stream Information area.

2. The Stream Scheduler dialog box opens.

3. Select the Load -Batch Scheduler tab.

4. Select the relevant Schedule Type and times and click Save.

You can view the status of each step of the ETL process and if you want more information on a
single step, mouse over the step and click More Info to view the additional information.

After the ETL Process completes, the data is available in the Executive Scorecard target schema,
meaning you can run the engine calculation for the selected KPIs and view the results in the
dashboard.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

Use Case - ITFM - Create an Allocation Scenario
In this section, you will learn how to create an allocation scenario.

1. Add an Allocation Scenario
a. In themain toolbar, click Finance > Allocation management.

b. In the AllocationManagement page left pane, click .

c. Enter a unique scenario name, description, and start and end period in the right pane.

d. Select theAffect Dashboard option if you want to display the new allocation scenario in
the Dashboard.

e. Select theReallocate Newest data option if you want the allocation scenario to be
automatically recalculated after new data is added.

For more details, see AllocationManagement Page in the Financial Analyst Guide.

2. Add an Allocation Stage to a Scenario

You can add an allocation stage, such as cost centers or organizations, to help you enhance
the cost information. You can further enrich the data with allocation rules that create new
records without changing the original data. The sequence of the allocation stages and
allocation rules determines how the allocation engine calculates the data.

a. Click thePlanned Cost Stages orActual Cost Stages tab.

Note that you can set a different scenario for Planned Cost and Actual Cost, but the
process is the same.

b. Click Add Stage. The Add Stage window opens.

c. Give the stage a name, description and select the dimension you want to use in this
specific stage and click Save.
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A new stage is created.

If you want to pass the whole amount and not just the allocated one to the next stage,
select thePass Full amount option.

For more details, see View, Define, Add, or Modify Allocation Stages in the Financial Analyst
Guide.

Youmust now define a rule to properly allocate the amounts.

3. Add an allocation rule to an allocation stage:

a. Click the relevant stage. The <Stage Window> dialog box opens.

You can view the list of rules used in the allocation stage in the List of Rules pane.

b. In the List of Rules pane, click Add Rule. The Add Rule wizard opens. Follow its
instructions and set the rule name and description.

Note: You can add a rule as a placeholder in the stage without defining the allocation
criteria immediately. The scenario remains in Draft mode until all rules are defined.

c. Click Next until you get to theRule Criteriawizard page. The Rule Criteria specifies the
conditions when the rule should be applied.

d. Drag a property or a dimension from the List of Dimension Properties to the right pane.
An operation box is displayed to the right.

e. Select the operation to be performed by the rule in the <operation list>. A value box opens
to the right.

f. Enter the value you want the operation to use, in the <value> box. This box can display a
list of values, if you selected a dimension with existing values, for example Application
Name orManager Name.

g. You can then either select another dimension and drag it to the right pane. A box is added to
the right pane where you can select either and or or to enable you to select how you want
to link the rule criteria, or you can click Next to define the rule's targets to which you want
to allocate the amounts and set the cost deviation between those targets.

h. Click Finish to return to the Allocation Stage detail page to view the list of rules.

The Allocation engine will then start the allocation process based on the stage you configured.
The status of the scenario changes toComplete and after that you can continue with creating
another stage and rules.

4. If needed, you can create additional stages until the scenario answers all your needs.

5. To test the scenario in the Cost explorer module, click the Test in Cost Explorer button. You
are redirected to the Cost explorer page presenting data based on the current allocation
scenario.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.
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Use Case - ITFM - Create Budget Template
In this section, you will learn how to create a budget template.

1. Create a budget:
a. Click Finance > Budget Management. In the Budget main page, click Add Budget to

start creating the Budget template.

b. In the New Budget dialog box enter the Budget Template name, set the time frame, start
period, frequency, and unit.

For more details, see Create Budgets in the Financial Analyst Guide.

2. Add Cost Centers to a budget:
a. Select a Cost Center that you want to include in the budget, in theAvailable cost centers

area or press Ctrl and click to select multiple Cost Centers.

b. Click the arrows tomove the selected Cost Centers to theSelected cost center area in
order to include these Cost Centers in the budget.

For more details, see Create Budgets in the Financial Analyst Guide.

3. Add cost categories to the Cost Category groups:
a. In theAvailable cost categories area, select the cost categories that you want to include

in the budget.

If you want to include one or more cost categories together under a single group, you can
do so by creating a group and assigning the relevant cost categories to it.

b. Click the group for which you want to add cost categories.

c. Click the arrow tomove the selected Cost Categories to theSelected cost categories
area.

d. Click the Finalize button to complete the budget template creation. You return to themain
Budget page.

For more details, see Create Budgets in the Financial Analyst Guide.

4. Notify the Cost Center Managers:
a. As the Budget Coordinator, you can send an email to the Cost Center Managers to let them

know that they should edit their budgets. To do so, click theNotify button.

b. TheNotification Management dialog box appears. You can email themanagers
separately, or together by checking the Check Box next to the relevant Cost Center and
clicking theSend button.

c. Edit the email message if needed and complete the process by sending the email and
closing theNotification Management dialog box.

The relevant Cost Center managers will receive an email regarding their Budget and each
one of them can log in, edit the relevant budgets, and notify the Budget Coordinator that the
budget is complete.

For more details, see Review, Accept, or Publish the Consolidated Budget in the Financial
Analyst Guide.
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Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

Use Case - ITFM - Edit a Budget
In this section, you will learn how to edit a budget that was created earlier by the Budget
Coordinator.

1. Click Finance > Budget Management.

2. In the Budget main page, select the budget you want to edit in the List of budgets and in the
Cost Centers area (bottom part of the page), click in theActions column next to the cost
center budget under your responsibility.

The Cost Center Budget View dialog is displayed.

3. Enter the relevant frequence in the Freq. drop down list.

4. You can set the amounts for each period and cost category according to the template the
Budget Coordinator created for you.

You can either enter the values manually or use an Excel sheet to import the values in one
click.

To use an Excel sheet, first Export the current template to an Excel file by clicking the Export
button. Once the file is generated, edit it , save it, and import it back to the application using the
Import button.

For more details, see Enter Budget Data for a Cost Center or Mark Cost Center Completed in
the Financial Analyst Guide.

5. You can ‘save’ a budget, stop working on it temporarily, and then continue to work on it later by
clicking theSave button. Once the budget is complete and ready to be reviewed by the Budget
Coordinator, click theComplete button and send it back for review by clicking theNotify
button.

6. The Budget Coordinator receives the notification and starts reviewing the Budget.

7. If additional work is needed on the budget, the Budget Coordination clicks theReject button
corresponding to the budget and notifies you. You can then perform the requested changes and
send the corrected budget back for an additional review.

8. Once the budget is approved, the Budget Coordinator approves it. When all Cost Centers
budgets have been approved, the Budget Coordinator finalizes the budget by clickingPublish.
The page closes. The budget status changes toPublished.

The published budget can be now be used in Allocations.

For more details, see Review, Accept, or Publish the Consolidated Budget in the Financial Analyst
Guide.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
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the relevant movie. For details, see "Movies" on page 89.

Use Case - ITFM - Analyze, in the Dashboard,
Financial Data Based on an Allocation

In this section you will learn how to analyze certain allocation scenario using the out-of-the-box
Dashboard pages.

1. In the Dashboard, click the Financial Summary tab, if it is displayed, or click thePage

Gallery button in the Dashboard toolbar, and drag the Financial Summary page outside
thePage Gallery box, and close the box.

This page displays a filter that the user can use to filter data based on a specific fiscal year by
selecting one of the values from the dropdown list.

Once you select a fiscal year, all the components in the page are refreshed with the
corresponding data.

This page displays 3 tiers:

n Tier 1 displays yearly data in a threshold bar with the ratio between Actual vs Planned Cost
for the selected year and 3 pie charts with the distribution of the Actual Costs by different
dimensions : Suppliers, Opex vs Capex, Discretionary and Non-discretionary.

n Tier 2 displays 2 overtime components.

o The first one shows the distribution of Actual and Planned Cost month-by-month for the
selected year.

o The second component shows the cumulation of Actual Costs from the beginning of the
year until the current month versusthe Total Planned Cost for that year.

In addition, this component displays 2 lines that show the year-over-year comparison
information.

n Tier 3 shows amulti-header table that displays the distribution of Actual and Planned costs
per locations.

When you select an item in the Tier 2 components, the table in Tier 3 is automatically
updated to display the related information.

For more details, see View the Financial Performance of Your Organization in the Financial
Analyst Guide.

2. You can change the type of periodicity type by selecting a different period from the drop down
list in the filter component.

3. TheCost Distribution Overview page is similar to the Financial Summary page but shows
data distributed by the selected Organization, Service, Customer, and Program.

These dimensions are hard-coded and the user can select one of them in the filter component.
In addition, the use can select a fiscal year and can sort items by highest over-budget, highest
planned costs or alphabetical order.
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The List component shows a list of all the business services, organizations, programs, or
customers in your enterprise, corresponding to the selected Page Type, available in the
selected fiscal year, and sorted by the selected sort type in the page filter. Once you select a
page type in the filter component, a list of values appears in the List component. Selecting one
of the items in that list will refresh data on all components.

This page is divided into 2 tiers.

n The second tier displays 2 overtime components. The first one shows the distribution of
Actual and Planned cost month-by-month for the selected year and for the specific item you
selected in the List component starting from the first month of the selected fiscal year.

n The second component shows the year-over-year ratio of Actual Costs versus the Total
Planned Cost month-by-month from the first month of the selected fiscal year.

Once you select a data point from one of the overtime charts, the right-hand bar chart
component displays data distributed by several dimensions, for example: Program,
Organization, Supplier and Cost category for business service item.

You can change the graph presentation from bars to grid.

For more details, see View the Distribution of Cost (Cost Distribution Overview Page) in the
Financial Analyst Guide.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

Use Case - ITFM - Analyze Allocation Scenarios
Using Cost Explorer

In this section, you will learn how to analyze an allocation scenario using Cost Explorer.

1. Click the Finance tab and select Cost Explorer from the navigationmenu.

2. Select the relevant scenario in theSelect Scenario drop down list.

3. Click Update Chart to display the configuration and analyze it.

The scenario data is displayed.

By default, you can view theActual vs Planned Allocations per Fiscal month scenario .

4. You can select other X-axis to display other points of view.

For example: change the A-axis from Fiscal month to Fiscal quarter and click the Update Chart
button. The Chart is updated according to your setting and presents the data per quarter.

5. In addition, you can change themeasurements from Actual vs Planned to other views.

For example: changeMeasurement 2 to Variance to Plan and click the Update Chart button.
The Chart is updated accordingly. You can define up to 3measurements.

6. If you want to filter out specific currencies, select theShow costs subset option, select the
relevant currency, and click theUpdate Chart button.
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7. You can group charts by up to 3 dimensions and receive the list of charts.

For example: select Budget line as the first Y-axis and click the Update Chart button.

8. The list of generated thumbnail charts is displayed in the top area. Select one of the charts
thumbnails to display it in expanded format in the bottom area.

When the result of the filtering includes more than a single chart, you can sort the results by
different aspects by selecting the relevant aspect in the Sort Chart bylist.

For more details, see Configure and View Cost Explorer in the Financial Analyst Guide.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

Use Case - IDE - Overview
In this movie you will learn about the XS DWH IDE. The DWH IDE provides themeans to extend
and develop DWH content.

DWH content is comprised of a set of Staging Area Datamodels, Target Area Datamodels and an
ETL (Extract Transform Load) process. The ETL is aimed at moving and transforming data entities
from the data source entities format to the Target Datamodel structure.

The eclipse tool contains 4 major areas:

l Workspace: The center of the screen is the canvas where you createmodels in the Architect
and Engineer contexts.

l Project Explorer:Contains the available projects.

l Palette area:Contains the tools for crating your content.

l Tabs:Contains the tabs with various property and error information.

Contexts:

The IDE provides twomain levels of metadatamodeling: The Architect context and the Engineer
context. The Architect context enables the user to model the DWH Target entities and the relations
between them. The Engineer context enables the user to create the sequence of models for data to
bemapped from the sourcemodel to the target entity model.

To the right of the canvas is the palette which contains the set of tools used to design the context

To the left of the canvas, the project explorer contains a set of out of the box content packs. This is
where all the content loaded into the IDE can be found.

The bottom area contains additional tabs such as the ‘problems’ view which provides indications of
model validation errors and the properties view which enables the configuration of entity attributes
and properties.

Usually, when starting the development of an entity, you begin with developing the Architect
context, designing the new target schema and then you develop the engineer context, loading the
target entity you created earlier and connecting to the data source schema.
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The Target Entity is comprised of Fact and Dimension tables, which can be linked to associated
dimensions.

The Source Entity is the actual and accurate representation of an entity to be extracted from the
source. It is automatically generated according to integration entity design.

The Integration Entity is a Source Table representation.

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

Use Case - IDE - Develop a New Entity
In this movie you will learn how to develop a new entity using the IDE. The development scope
includes the full content development track – from source to target . In this movie it is required to
create a new fact table since the requestedmeasurements do not exist in the OOTB scheme,
therefore wewill start with creating the Architect context and thenmove to the Engineer context.

The data that used in this example comes from PPM.

Let’s start with the importing of the relevant Content Packs.

1. Open the Eclipse IDE.

2. From the topmenu select File > Import.

3. Under the General folder select Existing Projects into workspace and click Next.

4. Browse for the cp-core folder and click OK, click Finish to import the project.

5. Repeat these steps for cp-ppm and cp-ppm-9.1-oracle content packs.

The next step is to create two new logical projects: Architect_Context and Engineer_
Context

1. From the topmenu select New > Project, expand theGeneral folder, select Project and click
Next. Enter the name Architect_Context and click Finish.

2. The project for storing the Architect context diagram is created and displayed in the Package
Explorer.

Repeat this procedure to create the Engineer_Context.

Now you can start designing the Architect context.

1. From the Package Explorer pane, select the Architect_Context folder you just created.

2. Right-click and select New > Other.

3. Select Architect Context and click Next.

4. Enter a file name, in this case :PROJECT_STATUS_CSTM.architectcontext_diagram and
click Next.

5. Click Browse and select cp-core and click OK.

6. Click Finish to finalize the context creation.
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7. In the palette area on the right side, select New Target Entity and click in the canvas.

8. Enter an entity name (‘PROJECT_STATUS_CSTM’) and click Enter.

9. In the Properties tab select General and select the Fact checkbox.

10. Add a Target column by clicking Target Column in the palette area and click in the
PROJECT_STATUS_CSTM entity frame.

11. For each column click Target Column and click in the PROJECT_STATUS_CSTM entity
area and enter the name of the column.

12. Double-click Load Target Entity (in the palette area).

13. Expand the Core folder and select PERIOD/ Period entity and click OK.

14. Repeat this step and select PROJECT/ Project entity.

15. Create a link between the Fact you created and the Dimensions you loaded in the previous
step by selecting Fact to Dimension in the palette area. Drag the arrow from the Fact column
in the entity to the Dimension you want it linked to.

16. Create another link between the Fact and the Period dimension.

17. In the Properties tab select Columns and set the Length of each column to 255 and the
Measure to True.

18. Save the configurations.

The design of Architecture context diagram is complete.

Now, you are ready to create the Engineer_Context.

1. From the Package Explorer pane select the Engineer_Context folder you created before, right
click and select New > Other. Select the Engineer Context and click Next.

2. Enter a file name for the Engineer Diagram (in this case PROJECT_STATUS_
CSTM.engineercontext_diagram) and click Next.

3. Select cp-core as the Target CP directory, cp-ppm as the Integration CP directory and cp-
ppm-9.1-oracle as the Source CP directory and click Finish. The Engineer Context diagram is
created and automatically opens.

4. In the palette area, click Load Target Entity, expand the Core folder and select the Target
entity you created earlier and click OK. The Target Entity is displayed.

The next step is to create a New Integration Entity.

1. In the palette area, click New Integration Entity, click in the canvas and enter a name.

2. In the palette area, click Integration Column and click inside the Integration Entity and enter
the column name.The column names must be exactly the same as in the source table.

3. In the Properties tab, select Columns and in theData Type column, set theData Type,
Length andBusiness Key accordingly

4. Save the configurations.

Create SSI mapping between the Interaction entity and Target entity
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1. In the palette area, click Column Mapping and drag a line between PROJECT_ID and
PROJECT.

2. Once the link is created a new entity is displayed: PPM –PROJECT_STATUS CTSM
Transformation.

3. Continue creating SSI mapping links accordingly.

4. Save your configurations.

Create a New Source Entity

1. In the palette area, click New Source Entity and click in the canvas.

2. Create a link between the New Source Entity and the Integration Entity, click Source to
Integration Relation in the palette area and drag the display arrow from the Source to the
Integration.

3. The name of the New Source Entity is automatically updated to PPM.9.1.oracle.PM_
PROJECT_RLP_CSTM.

4. In the Properties tab, select Columns and update the table name for all the records with the
original table name as it appears in the Data source DB.

5. In the Properties tab, select General and add the table name to the Table Name/Join
Condition and save.

The next step will be to generate the ETL.

Use Case - IDE - Extract an Existing Entity from the
New Data Source

In this movie you will learn how to extract an existing entity from a new data source using the IDE.

Specifically, to extract data from a non HP ChangedManagement application where their data was
exported to a CSV file.

The purpose is to send the data from the CSV file to the data warehouse, in order to transform the
data and put it into the Target schema so that the existing OOTB business context and KPIs can be
reused.

Let’s start with the modeling of the new source and integration entities.

1. Open the Eclipse IDE.

2. From the topmenu select File > Import.

3. Under the General folder select Existing Projects into workspace and click Next.

4. Browse for the cp-core folder and click OK, click Finish to import the project.

Now you need to create an Integration Content pack and link it to the Core Content pack.

1. From the topmenu select File > New > Other.

2. Select DWH IDE Wizards > Content Packs, select Integration Content Pack and click
Next.
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3. Specify the project name cp-cm (for ChangeManager) and click Next. Check the cp-core and
click Finish.

4. The Integration Content Pack is created.

The next step is to create the Source Content Pack and link it to the Integration CP.

1. From the topmenu select File > New > Other.

2. Select DWH IDE Wizards > Content Packs, select Source Content Pack and click Next.

3. In the Project Name specify cp-cm-1.0-generic (1.0 is the version of ChangeManager;
‘generic’ is the type of the data source that we extract the data from, in our case it’s a CSV file)
and click Next. Select cp-cm and click Finish.

4. The Source Content Pack is created.

Create an empty project for storing the Engineer Context Diagram.

1. From the topmenu select File > New > Project.

2. Expand theGeneral folder, select Project and click Next.

3. Specify a name, Engineer_Context and click Finish.

4. The project for storing the Engineer context diagram is created.

Now create the Engineer Context.

1. From the topmenu select File > New > Other.

2. Select DWH IDE Wizards > Engineer Context, and click Next.

3. Change the file name to CHANGE.engineercontext_diagram and click Next.

4. Select cp-core as the Target CP directory, cp-cm as the Integration CP directory and cp-cm-
1.0-generic as the Source CP directory and click Finish.

5. The Engineer context diagram is created and automatically opens.

Open an existing Target Entity.

1. Click Load Target Entity on the Palette and click in right part of the canvas to place it.

2. In the Resource Selector dialog box expand CORE, select CHANGE entity and click OK.

3. The CHANGE target entity containing all the relevant fields is added to the canvas.

Create a new Integration entity.

1. Click New Integration Entity on the Palette and click in the canvas to place it.

2. Change the name to CHANGE_CSTM.

3. Create the Integration entity fields.

4. Add the new field either by clicking Integration Column in the Palette and clicking the
CHANGE_CSTM entity to place the field or by clicking the star icon that appears when you
hover over the entity.

5. Create the set of fields that should be extracted from the CSV file (so that the columns that are
in the CSV match those in the existing Change entity and therefore can bemapped).

Define the Integration entity fields’ data types.
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1. Right-click on the CHANGE_CSTM name and select Show Properties View.

2. In the Properties tab select Columns.

3. Select the corresponding data types in the Data Type column, for VARCHAR data type
specify the Length.

4. In the ID column, the unique key for the Change entity, select 1 in the Business Key column for
the ID row and leave the rest empty.

Map the Integration entity fields to the Target entity fields.

1. In the Palette, click Column Mapping in the SSI section.

2. Select the ID field in the CHANGE_CSTM entity and drag the arrow to the REFERENCE_
NUMBER column in the CHANGE target entity.

3. The CM –CHANGE Transformation entity opens automatically as themapped entity.

4. In the samemanner, map the CHANGE_CSTM integration entity to the relevant CP –
CHANGE Transformation entity.

Create the Source entity.

1. In the Palette, click New Source Entity in the Source Entity section and then click to the left
from the CHANGE_CSTM Integration Entity to place it.

2. Link the Source Entity to the Integration entity.

3. Click Source to Integration Relation in the Source Entity section of the Palette

4. Link the newly created source entity with CHANGE_CSTM integration entity by dragging the
arrow from the Source Entity name to CHANGE_CSTM Integration Entity name.

5. The source entity is automatically renamedCM.1.0.GENERIC.CHANGE_CSTM

Specify the data source file in the Source Entity properties.

1. Right-click on the CM.1.0.GENERIC.CHANGE_CSTM source entity and select Show
Properties View.

2. In the Core tab specify Change.csv in the Table Name/Join Condition field.

The next step is to generate the ETL.

Use Case - End-to-End Data Flow

Movie: To display themovie, open the XS application in Internet Explorer 9 or Chrome, click
Help in the top right corner of the applicationmain page and select theMovies option. Select
the relevant movie. For details, see "Movies" on page 89.

HP IT Executive Scorecard (9.31)Page 62 of 92

Getting Started Guide



End-to-End Flows
This section describes themajor end-to-end flows youmust execute to view your scorecards and
KPIs in the Dashboard. The flow depends on the type of data source.

This section includes the following flows:

Flow 1: View Data from External Data Sources 63

Flow 2: View your Scorecards and KPIs Based on Alternate Source Data 66

Flow 3: View Data from an External File 68

Flow 1: View Data from External Data Sources
This section presents the high level end -to-end flow you can follow to view your Scorecards and
KPIs in the HP IT Executive Scorecard Dashboard. The data displayed in the Dashboard is based
on data from:

l HP Application Lifecycle Management (ALM)

l HP Asset Manager (AM)

l HP Business ServiceManagement (BSM) and (Application PerformanceManagement (BSM-
APM))

l HP Data Protector (DP)

l HP Insight Control (IC)

l HP Network Automation (NA)

l HP Network NodeManager (NNM)

l HP Operation Orchestration (OO)

l HP Project and Portfolio Management (PPM)

l HP Server Automation (SA)

l HP Storage Essentials (SE)

l HP ServiceManager (SM)

l HP Universal ConfigurationManagement Database (UCMDB)

Prerequisite:
1. Read theExecutive Scorecard Release Notes available on the Installation DVD. The

document includes release notes, getting started information, installation and upgrade
information, and troubleshooting notes.
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2. Install Executive Scorecard and run the post-install wizard. For details, see theExecutive
Scorecard Installation and Configuration (interactive document) available on the Installation
DVD.

3. Set up the users, permissions, and other general settings. For details, see "Getting Started" in
General Administration in the online documentation library or in theGeneral Admin Guide.

Perform the integration with the Data Sources:
1. Check the relevant integration documentation for eventual prerequisite steps. For more

information, see in theContent ReferenceGuide:

n "Integrate with the ALM Data Source"

n "Integrate with the AM Data Source"

n "Integrate with the BSMData Source"

n "Integrate with the DP Data Source"

n Integrate with the IC Data Source

n "Integrate with the NA Data Source"

n "Integrate with the NNMData Source"

n "Integrate with the OOData Source"

n "Integrate with the PPMData Source"

n Integrate with the SA Data Source

n Integrate with the SE Data Source

n "Integrate with the SM Data Source"

n "Integrate with the UCMDB Data Source"

2. Select Admin > Data Source Management then click Add data source. Select the
relevant data source instance. Fill out the relevant fields and click Next.

3. Wait until the activation process is complete.

Run the corresponding ETL.
1. Select Admin > ETL Management.

2. Schedule a periodic task. For details, see "To verify or schedule the run_steps command:" in
theAdministrator Guide.

3. Create a new ETL work-list for loading new data from sources. For details, see "To load
or resume a batch job:" in theAdministrator Guide.

4. Schedule the ETL batch to run once or twice a day. For details, see "To schedule a batch
job:" in theAdministrator Guide

5. Check the status of the ETL process to see if it has completed. For details, see "To view
active streams:" in theAdministrator Guide. You can then drill down for more details. For more
details, see "DW ABC Streams Management User Interface" in theAdministrator Guide.
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Review in the Studio KPI library, the out-of-the-box Scorecards,
Perspectives, Objectives, and the KPIs
1. Click theStudio tab.

2. Click theShow Trees Side-by-Side icon in the top right corner of the Active KPIs pane to
display the KPI Library pane.

3. Select the relevant Scorecards, Perspectives, Objectives, and KPIs of interest to your
organization and drag them from the KPI Library (templates) to the Active KPIs Pane to
activate them.

4. You can now run calculations or historical calculations depending on your needs:
a. In the Active KPIs pane, select the KPI you havemodified. Click theCalculation options

button in the Active KPIs toolbar, and select theRecalculate option. In the
Recalculate dialog box that opens, select the relevant context and click Calculate. For
details, see "Recalculate Displayed Values after Configuration Change" in theBusiness
Analyst Guide.

b. In the Active KPIs pane, click theCalculation options button in the Active KPIs
toolbar, and select:

i. TheCalculate now option.In the Calculate Now dialog box that opens, select
the relevant context and click Calculate. For details, see "Calculate Displayed
Values after Configuration Change" in theBusiness Analyst Guide.

ii. TheSchedule context calculation option. In the Business Context Calculation
Scheduling dialog box that opens, select the schedule. For details, see "Schedule
Business Context Calculations" in theBusiness Analyst Guide.

iii. The Calculation monitoring option . In theCalculationMonitoring Dialog Box
dialog box that opens, select the schedule. For details, see "Monitor the Calculation
and Recalculation Processes" in theBusiness Analyst Guide.

5. Once the calculation is completed, go to the Dashboard and open the relevant out-of-the-box
page, or create a new page, select the filter for each component, and view the results. For
details, see "Manage Pages" in theBusiness Analyst Guide.
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Flow 2: View your Scorecards and KPIs Based on
Alternate Source Data

This section presents the high level end -to-end flow you can follow to view data from an alternate
data source in the HP IT Executive Scorecard Dashboard.

The data displayed in the Dashboard is based on data from:

The alternate source is an Excel file that includes data from the supported data sources and third-
party applications.

Prerequisite:
1. Read theExecutive Scorecard Release Notes available on the Installation DVD. The

document includes release notes, getting started information, and installation and upgrade
information.

2. Install Executive Scorecard and run the post-install wizard. For details, see theExecutive
Scorecard Installation and Configuration (interactive document) available on the Installation
DVD.

3. Set up the users, permissions, and other general settings. For details, see "Getting Started" in
General Administration in the online documentation library or in theGeneral Admin Guide.

4. Troubleshooting issues are detailed in the IT Executive Scorecard Troubleshooting Guide in
Excel format.

Perform the integration with an alternate data source:
1. Take the sample files from < Installation Directory>\agora\Content

Packs\ETL\flatfiles\demodata, create your own according to the rules and save them in the
External sources directory (in C:\EXTERNAL).

2. To activate the ALT content pack, go through the automation backend tool. For details, see
"The Automation Tool" (on page 1) in theAdministrator Guide.

3. Wait until the activation process is complete.

For more information, see "Alternate Sources Integration" in theContent ReferenceGuide.

Run the corresponding ETL.
1. Select Admin > ETL Management.

2. Schedule a periodic task. For details, see "To verify or schedule the run_steps command:" in
theAdministrator Guide.

3. Create a new ETL work-list for loading new data from sources. For details, see "To load
or resume a batch job:" in theAdministrator Guide.

4. Schedule the ETL batch to run once or twice a day. For details, see "To schedule a batch
job:" in theAdministrator Guide

5. Check the status of the ETL process to see if it has completed. For details, see "To view
active streams:" in theAdministrator Guide. You can then drill down for more details. For more
details, see "DW ABC Streams Management User Interface" in theAdministrator Guide.
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Review in the Studio KPI library, the out-of-the-box Scorecards,
Perspectives, Objectives, and the KPIs
1. Click theStudio tab.

2. Click theShow Trees Side-by-Side icon in the top right corner of the Active KPIs pane to
display the KPI Library pane.

3. Select the relevant Scorecards, Perspectives, Objectives, and KPIs of interest to your
organization and drag them from the KPI Library (templates) to the Active KPIs Pane to
activate them.

4. You can now run calculations or historical calculations depending on your needs:
a. In the Active KPIs pane, select the KPI you havemodified. Click theCalculation options

button in the Active KPIs toolbar, and select theRecalculate option. In the
Recalculate dialog box that opens, select the relevant context and click Calculate. For
details, see "Recalculate Displayed Values after Configuration Change" in theBusiness
Analyst Guide.

b. In the Active KPIs pane, click theCalculation options button in the Active KPIs
toolbar, and select:

i. TheCalculate now option.In the Calculate Now dialog box that opens, select
the relevant context and click Calculate. For details, see "Calculate Displayed
Values after Configuration Change" in theBusiness Analyst Guide.

ii. TheSchedule context calculation option. In the Business Context Calculation
Scheduling dialog box that opens, select the schedule. For details, see "Schedule
Business Context Calculations" in theBusiness Analyst Guide.

iii. The Calculation monitoring option . In theCalculationMonitoring Dialog Box
dialog box that opens, select the schedule. For details, see "Monitor the Calculation
and Recalculation Processes" in theBusiness Analyst Guide.

5. Once the calculation is completed, go to the Dashboard and open the relevant out-of-the-box
page, or create a new page, select the filter for each component, and view the results. For
details, see "Manage Pages" in theBusiness Analyst Guide.
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Flow 3: View Data from an External File
You can upload data from an external file into the Studio using Context Designer:

1. Upload data in .CSV format using the Context Designer. For details, see "Create andManage
Contexts Using Context Designer" in theAdministrator Guide.

2. Create KPIs based on the new Context.

3. Calculate the KPIs.

4. Display the calculation results in the Dashboard.
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Customization
This section includes the following topics:

Customize KPIs 69

Other Customizations 70

Customize KPIs
Executive Scorecard enables you to customize KPIs as follows:

You can:

l Activate KPIs by dragging KPI templates from the KPIs Library pane to the Active KPIs pane in
the Studio. For details, see "Activate Scorecards, Perspectives, Objectives, Metrics, or KPIs
Using Templates" in theBusiness Analyst Guide.

l Create KPIs by cloning existing active KPIs. For details, see "Create Active Scorecards,
Perspectives, Objectives, Metrics, or KPIs" in theBusiness Analyst Guide.

l Customize a formula or filter. For details, see "Modify a KPI or Metric Formula" or "Modify a KPI
or Metric Filter" in theBusiness Analyst Guide.

l Customize a KPI's Context. For details, see "Customize a KPI or aMetric Business Context" in
theBusiness Analyst Guide.

l Enrich the Dashboard contents with Metric Breakdowns and KPIs, overrides, Cascading
Scorecards, andmore. For details, see "Enrich the Dashboard Contents" in theBusiness
Analyst Guide.

l Create andmanage Breakdowns for a KPI or aMetric according to the KPI or aMetric
dimensions. For details, see "Manage KPI Breakdowns" or "ManageMetric Breakdowns" in the
Business Analyst Guide.

When you configure a KPI Breakdown, its configuration (for example, formula, or period) is the
same as the parent KPI's configuration. Youmay want to have a different threshold or owner for
specific "branches" of the KPI Breakdowns. In addition, youmay want to change the thresholds
of some of the KPI Breakdowns. For details, see "ManageOverrides" in theBusiness Analyst
Guide.

l Add information to a KPI. That information can be a link to a relevant Dashboard page, an
external URL, a BO report that provides more information about the KPI, an Xcelsius report
configured in the system. This additional information can help the Executive by providing
external information related to a KPI, or more details about the KPI's value, status, and score, in
the right pane of the Explorer tab. For details, see "Provide Additional Information for a KPI or an
Objective" in theBusiness Analyst Guide.
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Other Customizations
You can also customize the following:

l Objectives, Perspectives, or Scorecards. For details, see "Configure anObjective",
"Configure a Perspective", "Configure a Scorecard", or "Assign/Unassign KPIs to/from
Objectives" in theBusiness Analyst Guide.

l Dashboard Pages. For details, see "Add a Page to the Dashboard" or "Configure a Page
Layout" in theBusiness Analyst Guide.

How to Find Information
This section includes the following topics:

"Documentation Library" below

"Search Help Center" on page 74

"Access the Online Help Pages Relevant to the Currently Displayed UI Page" on page 74

"Documentation Updates" on page 78

"Movies" on page 79

Documentation Library
Executive Scorecard Help Center includes the following documents:

Document Description Available
Formats

Location

Release
Notes

Includes last
minute
information,
fixed issues,
and
limitations.

PDF Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

Support Matrix Describes
hardware
requirements,
software
requirements,
and supported
environments.

PDF Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport
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Document Description Available
Formats

Location

Upgrade
Guide

Describes
how to
upgrade
Executive
Scorecard to
the new
version

PDF Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

Getting
Started Guide

Provides
useful
information for
getting up and
running with
Executive
Scorecard.

Getting
Started with
IT Executive
Scorecard in
PDF format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

General
Administration
Guide

Describes
Executive
Scorecard
Admin-
istration
tasks.

Administrator
Guide
in PDF format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

Business
Analyst User
Guide

Describes
how to work
with
Executive
Scorecard
Studio and
Dashboard to
create and
activate
Scorecards,
Perspectives,
Objectives,
Metrics, and
KPIs.

Business
Analyst Guide
in PDF format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport
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Document Description Available
Formats

Location

Financial
Analyst User
Guide

Describes
how to use
the
ITFM module
to consolidate
and allocate
planned and
actual costs
from HP
Asset
Manager, HP
Project and
Portfolio
Management,
and alternate
data.

Financial
Analyst Guide
in PDF format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

Content
Reference
Guide

Provides
reference
information on
Contexts
(universes),
out-of-the-box
KPIs and
metrics, Web
intelligence
and
operational
reports, and
integrations
with
supported
data sources.

Content
Reference
Guide in PDF 
format

Available with the download of 9.31 from the
HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport

Content
Extension
Guide

Includes
information on
extending
content and
developing
new content
using the
Integrated
Development
Environment
(IDE).

PDF Available from the Executive Scorecard 9.31
in the HP Software Product Manual Site (
http://h20230.www2-
.hp.com/selfsolve/manuals).
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Document Description Available
Formats

Location

Open Source
and Third
Party
Software
License
Agreements

Contains the
license
information for
open source
and third-party
software
included in
Executive
Scorecard.

PDF Help Center and DVD

Getting
Started with
XS for
Smartphone

Provides
information on
viewing
Executive
Scorecard on
a smartphone.

Getting
Started with
XS for Mobile
in PDF format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

Getting
Started with
XS for Tablet

Provides
information on
viewing
Executive
Scorecard on
a tablet.

Getting
Started with
XS for Tablet
in PDF format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

KPI and
Metric List

Provides a list
of the out-of-
the-box KPIs
andMetrics,
their
description,
business
motivation,
formula,
context, and
more.

List of KPIs
and Entities in
Excel format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

List of Entities Provides a list
of the
available
Dimension
and Fact
entities for the
OOTB Data
Warehouse
Content
Packs.

List of
Entities in
Excel format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport
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Document Description Available
Formats

Location

Trou-
bleshooting

Provides
trou-
bleshooting
information,
workarounds,
and
knowl-
edgebase
items

Trou-
bleshooting
Issues in
Excel format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

ETL Process
and
Architectural
Overview

Provides a
graphic
representation
of the
ETL process
and its
architecture.

PDF Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

Search Help Center
To search Help Center, click theSearch button at the bottom left corner of the Help Center Home
page.

You can search for a single word, multiple words, or a specific combination of words that are
always next to each in the same order. To search for a specific combination of words, enter the
search words within quotationmarks in theSearch box. For example: “out-of-the-box KPIs”.

To search for a specific string in a specific Guide, select Search, enter the relevant string in the
Search box, and then select the guide in theSearch filters drop down list.

Access the Online Help Pages Relevant to the
Currently Displayed UI Page

How to access the online help depends on where you are in the application.

General Online Help
To access the general online help (the complete Documentation Library), click Help in the top right
corner of the application display, then select Documentation library.

Admin tab Online Help
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l To access the online help for the relevant page in theAdmin tab, open the relevant page using
the accordion tabs and their menu options, and click Help in the top right corner of the page.

l To access the online help for dialog boxes that are opened from the Admin tab pages, click the
Help button at the bottom of the dialog box. If the dialog box does not have a Help button, its
documentation is included in themain page documentation accessed by clickingHelp in the top
right corner of the page.

Explorer tab Online Help
To access the online help in theExplorer tab, click Help in the top right corner of the page.

Finance tab Online Help
To access the online help in the Finance tab, open the relevant page, and click Help in the top right
corner of the page.

Studio tab Online Help.
 To access the online help in theStudio tab:
l Click the Studio tab and click Help in the top right corner of the page to display general

information about the Studio and how to work with it.
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l Click Read more... in the top area of theKPI Library orActive KPIs pane to access the online
help for these panes.

l Right-click any item (Scorecard, Perspective, Objective, KPI, Metric, Folder, andmore) in the
tree of the theKPI Library orActive KPIs pane to display amenu, and then select the Help
menu item to display the online help for the item.
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l Click Help in the top right corner of the dialog box to display the relevant online help.

Dashboard Online Help
 To access the online help in theDashboard:
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l Close all tabs and click the relevant icon in the top right corner of the Dashboard page and click
theHelp button at the bottom of the dialog box that opens to display the online help for the dialog
box.

l Click the icon in the component toolbar and click theHelpmenu item to display the online
help for the component.

Documentation Updates
Executive Scorecard documentation is also available on the HP SoftwareManuals site.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.
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Youwill also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.

To replace the current documentation in your system with the recently updated documentation
obtained from theManual site, proceed as follows:

l Copy the online help to the <HPXS>\agora\docs\<language_country code>\directory
where <language_country_code> is: en_US for English language documentation and ja_JP for
Japanese language documentation.

l Copy the PDFs to the <HPXS>\agora\docs\<language_country code>\pdfs\ directory
where <language_country_code> is: en_US for English language documentation and ja_JP for
Japanese language documentation.

l Copy the post-install online help to the <HPXS>\agora\configwizard\docs\ directory.

Movies
To access the out-of-the-box movies:

1. You need Internet Explorer 9 or Chrome to display the contents..

2. Click Help in the top right corner of the applicationmain page and select the  Movies option.

The following page opens:

3. Select the relevant movie in the list to display the contents.

Note: If you are working with Internet Explorer 9 and do not see themovie, make sure that the
Compatibility View is off (indicated by the icon in the Explorer page).
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For details about themovie scripts, see "CommonUse Cases" on page 31 in theGetting Started
with IT Executive Scorecard.
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How to Find Information
This section includes the following topics:

"Documentation Library" below

"Search Help Center" on page 85

"Access the Online Help Pages Relevant to the Currently Displayed UI Page" on page 85

"Documentation Updates" on page 89

"Movies" on page 89

Documentation Library
Executive Scorecard Help Center includes the following documents:

Document Description Available
Formats

Location

Release
Notes

Includes last
minute
information,
fixed issues,
and
limitations.

PDF Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

Support Matrix Describes
hardware
requirements,
software
requirements,
and supported
environments.

PDF Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

Upgrade
Guide

Describes
how to
upgrade
Executive
Scorecard to
the new
version

PDF Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

Getting
Started Guide

Provides
useful
information for
getting up and
running with
Executive
Scorecard.

Getting
Started with
IT Executive
Scorecard in
PDF format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport
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Document Description Available
Formats

Location

General
Administration
Guide

Describes
Executive
Scorecard
Admin-
istration
tasks.

Administrator
Guide
in PDF format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

Business
Analyst User
Guide

Describes
how to work
with
Executive
Scorecard
Studio and
Dashboard to
create and
activate
Scorecards,
Perspectives,
Objectives,
Metrics, and
KPIs.

Business
Analyst Guide
in PDF format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

Financial
Analyst User
Guide

Describes
how to use
the
ITFM module
to consolidate
and allocate
planned and
actual costs
from HP
Asset
Manager, HP
Project and
Portfolio
Management,
and alternate
data.

Financial
Analyst Guide
in PDF format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport
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Document Description Available
Formats

Location

Content
Reference
Guide

Provides
reference
information on
Contexts
(universes),
out-of-the-box
KPIs and
metrics, Web
intelligence
and
operational
reports, and
integrations
with
supported
data sources.

Content
Reference
Guide in PDF 
format

Available with the download of 9.31 from the
HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport

Content
Extension
Guide

Includes
information on
extending
content and
developing
new content
using the
Integrated
Development
Environment
(IDE).

PDF Available from the Executive Scorecard 9.31
in the HP Software Product Manual Site (
http://h20230.www2-
.hp.com/selfsolve/manuals).

Open Source
and Third
Party
Software
License
Agreements

Contains the
license
information for
open source
and third-party
software
included in
Executive
Scorecard.

PDF Help Center and DVD

Getting
Started with
XS for
Smartphone

Provides
information on
viewing
Executive
Scorecard on
a smartphone.

Getting
Started with
XS for Mobile
in PDF format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport
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Document Description Available
Formats

Location

Getting
Started with
XS for Tablet

Provides
information on
viewing
Executive
Scorecard on
a tablet.

Getting
Started with
XS for Tablet
in PDF format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

KPI and
Metric List

Provides a list
of the out-of-
the-box KPIs
andMetrics,
their
description,
business
motivation,
formula,
context, and
more.

List of KPIs
and Entities in
Excel format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

List of Entities Provides a list
of the
available
Dimension
and Fact
entities for the
OOTB Data
Warehouse
Content
Packs.

List of
Entities in
Excel format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

Trou-
bleshooting

Provides
trou-
bleshooting
information,
workarounds,
and
knowl-
edgebase
items

Trou-
bleshooting
Issues in
Excel format

Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

ETL Process
and
Architectural
Overview

Provides a
graphic
representation
of the
ETL process
and its
architecture.

PDF Available with the download of the version
from the HP Software Support Online web site
at:
http://www.hp.com/go/hpsoftwaresupport

HP IT Executive Scorecard (9.31)Page 84 of 92

Getting Started Guide
How to Find Information



Search Help Center
To search Help Center, click theSearch button at the bottom left corner of the Help Center Home
page.

You can search for a single word, multiple words, or a specific combination of words that are
always next to each in the same order. To search for a specific combination of words, enter the
search words within quotationmarks in theSearch box. For example: “out-of-the-box KPIs”.

To search for a specific string in a specific Guide, select Search, enter the relevant string in the
Search box, and then select the guide in theSearch filters drop down list.

Access the Online Help Pages Relevant to the
Currently Displayed UI Page

How to access the online help depends on where you are in the application.

General Online Help
To access the general online help (the complete Documentation Library), click Help in the top right
corner of the application display, then select Documentation library.

Admin tab Online Help
l To access the online help for the relevant page in theAdmin tab, open the relevant page using

the accordion tabs and their menu options, and click Help in the top right corner of the page.

l To access the online help for dialog boxes that are opened from the Admin tab pages, click the
Help button at the bottom of the dialog box. If the dialog box does not have a Help button, its
documentation is included in themain page documentation accessed by clickingHelp in the top
right corner of the page.

Explorer tab Online Help
To access the online help in theExplorer tab, click Help in the top right corner of the page.
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Finance tab Online Help
To access the online help in the Finance tab, open the relevant page, and click Help in the top right
corner of the page.

Studio tab Online Help.
 To access the online help in theStudio tab:
l Click the Studio tab and click Help in the top right corner of the page to display general

information about the Studio and how to work with it.

l Click Read more... in the top area of theKPI Library orActive KPIs pane to access the online
help for these panes.
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l Right-click any item (Scorecard, Perspective, Objective, KPI, Metric, Folder, andmore) in the
tree of the theKPI Library orActive KPIs pane to display amenu, and then select the Help
menu item to display the online help for the item.

l Click Help in the top right corner of the dialog box to display the relevant online help.
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Dashboard Online Help
 To access the online help in theDashboard:
l Close all tabs and click the relevant icon in the top right corner of the Dashboard page and click

theHelp button at the bottom of the dialog box that opens to display the online help for the dialog
box.

l Click the icon in the component toolbar and click theHelpmenu item to display the online

HP IT Executive Scorecard (9.31)Page 88 of 92

Getting Started Guide
How to Find Information



help for the component.

Documentation Updates
Executive Scorecard documentation is also available on the HP SoftwareManuals site.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.

To replace the current documentation in your system with the recently updated documentation
obtained from theManual site, proceed as follows:

l Copy the online help to the <HPXS>\agora\docs\<language_country code>\directory
where <language_country_code> is: en_US for English language documentation and ja_JP for
Japanese language documentation.

l Copy the PDFs to the <HPXS>\agora\docs\<language_country code>\pdfs\ directory
where <language_country_code> is: en_US for English language documentation and ja_JP for
Japanese language documentation.

l Copy the post-install online help to the <HPXS>\agora\configwizard\docs\ directory.

Movies
To access the out-of-the-box movies:

1. You need Internet Explorer 9 or Chrome to display the contents..

2. Click Help in the top right corner of the applicationmain page and select the  Movies option.

The following page opens:
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3. Select the relevant movie in the list to display the contents.

Note: If you are working with Internet Explorer 9 and do not see themovie, make sure that the
Compatibility View is off (indicated by the icon in the Explorer page).

For details about themovie scripts, see "CommonUse Cases" on page 31 in theGetting Started
with IT Executive Scorecard.
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Videos
The following videos are available on the Internet:

HP IT Executive Scorecard -- Overview (http://www.youtube.com/watch?v=-TAySeyF4bU)

A Day in the Life of a VP of Operations (http://www.youtube.com/watch?v=nx_GMlLrrUI )
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